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VISION 

❖ To establish a pedestal for the integral innovation, team spirit, originality and 

competence in the students, expose them to face the global challenges and become 

technology leaders of Indian vision of modern society. 

 

MISSION 

❖ To become a model institution in the fields of Engineering, Technology and 

Management.  

❖ To impart holistic education to the students to render them as industry ready 

engineers. 

❖ To ensure synchronization of MRCET ideologies with challenging demands of 

International Pioneering Organizations. 

 

QUALITY POLICY 

❖ To implement best practices in Teaching and Learning process for both UG and PG 

courses meticulously.  

❖ To provide state of art infrastructure and expertise to impart quality education.  

❖ To groom the students to become intellectually creative and professionally 

competitive. 

❖ To channelize the activities and tune them in heights of commitment and sincerity, 

the requisites to claim the never - ending ladder of SUCCESS year after year. 

 

For more information: www.mrcet.ac.in 

http://www.mrcet.ac.in/
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VISION 

To become an innovative knowledge center in mechanical engineering through state-of-

the-art teaching-learning and research practices, promoting creative thinking 

professionals. 

MISSION 

The Department of Mechanical Engineering is dedicated for transforming the students 

into highly competent Mechanical engineers to meet the needs of the industry, in a 

changing and challenging technical environment, by strongly focusing in the 

fundamentals of engineering sciences for achieving excellent results in their professional 

pursuits. 

Quality Policy 

  To pursuit global Standards of excellence in all our endeavors namely teaching, 

research and continuing education and to remain accountable in our core and 

support functions, through processes of self-evaluation and continuous 

improvement. 

  To create a midst of excellence for imparting state of art education, industry-

oriented training research in the field of technical education. 
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PROGRAM OUTCOMES 

Engineering Graduates will be able to: 

1. Engineering knowledge: Apply the knowledge of mathematics, science, engineering 

fundamentals, and an engineering specialization to the solution of complex engineering 

problems. 

2. Problem analysis: Identify, formulate, review research literature, and analyze complex 

engineering problems reaching substantiated conclusions using first principles of 

mathematics, natural sciences, and engineering sciences. 

3. Design/development of solutions: Design solutions for complex engineering problems 

and design system components or processes that meet the specified needs with 

appropriate consideration for the public health and safety, and the cultural, societal, and 

environmental considerations. 

4. Conduct investigations of complex problems: Use research-based knowledge and 

research methods including design of experiments, analysis and interpretation of data, 

and synthesis of the information to provide valid conclusions. 

5. Modern tool usage: Create, select, and apply appropriate techniques, resources, and 

modern engineering and IT tools including prediction and modeling to complex 

engineering activities with an understanding of the limitations. 

6. The engineer and society: Apply reasoning informed by the contextual knowledge to 

assess societal, health, safety, legal and cultural issues and the consequent 

responsibilities relevant to the professional engineering practice. 

7. Environment and sustainability: Understand the impact of the professional engineering 

solutions in societal and environmental contexts, and demonstrate the knowledge of, and 

need for sustainable development. 

8. Ethics: Apply ethical principles and commit to professional ethics and responsibilities and 

norms of the engineering practice. 

9. Individual and teamwork: Function effectively as an individual, and as a member or 

leader in diverse teams, and in multidisciplinary settings. 

10. Communication: Communicate effectively on complex engineering activities with the 

engineering community and with society at large, such as, being able to comprehend and 

write effective reports and design documentation, make effective presentations, and give 

and receive clear instructions. 

11. Project management and finance: Demonstrate knowledge and understanding of the 

engineering and management principles and apply these to one’s own work, as a member 

and leader in a team, to manage projects and in multidisciplinary environments. 
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12. Life-long learning: Recognize the need for and have the preparation and ability to 

engage in independent and life-long learning in the broadest context of technological 

change. 

PROGRAM SPECIFIC OUTCOMES (PSOs) 

PSO1 Ability to analyze, design and develop Mechanical systems to solve the 

Engineering problems by integrating thermal, design and manufacturing Domains. 

PSO2 Ability to succeed in competitive examinations or to pursue higher studies or 

research. 

PSO3 Ability to apply the learned Mechanical Engineering knowledge for the 

Development of society and self. 

Program Educational Objectives (PEOs) 

The Program Educational Objectives of the program offered by the department are broadly 

listed below: 

PEO1: PREPARATION 

To provide sound foundation in mathematical, scientific and engineering fundamentals 

necessary to analyze, formulate and solve engineering problems. 

PEO2: CORE COMPETANCE 

To provide thorough knowledge in Mechanical Engineering subjects including theoretical 

knowledge and practical training for preparing physical models pertaining to Thermodynamics, 

Hydraulics, Heat and Mass Transfer, Dynamics of Machinery, Jet Propulsion, Automobile 

Engineering, Element Analysis, Production Technology, Mechatronics etc. 

PEO3: INVENTION, INNOVATION AND CREATIVITY 

To make the students to design, experiment, analyze, interpret in the core field with the help of 

other inter disciplinary concepts wherever applicable. 

PEO4: CAREER DEVELOPMENT 

To inculcate the habit of lifelong learning for career development through successful completion 

of advanced degrees, professional development courses, industrial training etc. 
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PEO5: PROFESSIONALISM 

To impart technical knowledge, ethical values for professional development of the student to 

solve complex problems and to work in multi-disciplinary ambience, whose solutions lead to 

significant societal benefits.  
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Blooms Taxonomy 

Bloom’s Taxonomy is a classification of the different objectives and skills that educators set for 

their students (learning objectives). The terminology has been updated to include the following 

six levels of learning. These 6 levels can be used to structure the learning objectives, lessons, 

and assessments of a course.   

1. Remembering: Retrieving, recognizing, and recalling relevant knowledge from long‐ term 

memory. 

2. Understanding: Constructing meaning from oral, written, and graphic messages through 

interpreting, exemplifying, classifying, summarizing, inferring, comparing, and explaining. 

3. Applying: Carrying out or using a procedure for executing or implementing. 

4. Analyzing: Breaking material into constituent parts, determining how the parts relate to 

one another and to an overall structure or purpose through differentiating, organizing, and 

attributing. 

5. Evaluating: Making judgments based on criteria and standard through checking and 

critiquing. 

6. Creating: Putting elements together to form a coherent or functional whole; reorganizing 

elements into a new pattern or structure through generating, planning, or producing. 
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 (R20A0307) COMPUTER AIDED MACHINE DESIGN 

COURSE OBJECTIVES: 

1. To familiarize with the standard conventions for different materials and machine 

parts in working drawings.   

2. To gain knowledge of conventional representation of various machining and 

mechanical details as per IS.  

3. To gain knowledge of threads, bolts, nuts, stud bolts, tap bolts, set screws, Keys, 

cottered joints and knuckle joint.  

4. To make part drawings including sectional views for various machine elements. 

5. To prepare assembly drawings given the details of part drawings. 

Part A: Drawing of Machine Elements and simple parts  

Selection of Views, additional views for the following machine elements and parts with 

every drawing proportion.  

1. Popular forms of Screw threads, bolts, nuts, stud bolts, tap bolts, set screws.  

2. Keys, cottered joints and knuckle joint.  

3. Rivetted joints for plates 

4. Shaft coupling, spigot and socket pipe joint. 

5. Journal, pivot and collar and foot step bearings. 

Part B: Assembly Drawings 

Drawings of assembled views for the part drawings of the following using conventions and 

easy drawing proportions.  

1. Steam engine parts – stuffing boxes, cross heads, Eccentrics. 

2. Machine tool parts: Tail stock, Tool Post, Machine Vices.  

3. Other machine parts - Screws jacks, Petrol engine connecting rod, Plummer block, 

Fuel Injector 

4. Valves - Steam stop valve, spring loaded safety valve, feed check valve and air cock. 

NOTE:  

1. First angle projection to be adopted. The student should be able to provide working 

drawings of actual parts. 

2. Part A need to be done by using AUTOCAD and Part B need to be done by using Creo. 
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TEXT BOOKS:  

1. Machine Drawing –K.L.Narayana, P.Kannaiah&K.VenkataReddy / New Age/ 

Publishers  

2. Machine Drawing with Auto CAD / Goutham Pohit, Goutam Ghosh / Pearson 

3. Machine Drawing / N.D. Bhatt / Charotar 

REFERENCE BOOKS:  

1. Machine Drawing by / Bhattacharyya / Oxford  

2. Machine Drawing / Ajeet Singh / Mc Graw Hill 

3. Machine Drawing –P.S.Gill. 

COURSE OUTCOMES: 

1. Preparation of engineering and working drawings with dimensions and bill of 

material during design and development. Developing assembly drawings using part 

drawings of machine components.  

2. Conventional representation of materials, common machine elements and parts 

such as screws, nuts, bolts, keys, gears, webs, ribs. 

3. Types of sections – selection of section planes and drawing of sections and auxiliary 

sectional views. Parts not usually sectioned. 

4. Methods of dimensioning, general rules for sizes and placement of dimensions for 

holes, centers, curved and tapered features.  

5. Title boxes, their size, location and details - common abbreviations and their liberal 

usage. Types of drawings – working drawings for machine parts. 

  



 

 

INTRODUCTION 
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Course Objectives: 

CO1: To familiarize with the standard conventions for different materials and machine parts in 

working drawings. 

CO2. To gain knowledge of conventional representation of various machining and mechanical 

details as per IS. 

Course Outcomes: 

Conventional representation of materials, common machine elements 

 

COURSE OUTLINE 

 

LECTURE LECTURE TOPIC KEY ELEMENTS LEARNING OBJECTIVES 

(2 to 3 objectives) 

1.  Introduction to IS 
conventions 

Materials, 
machine 
component 

Understanding the representation of 
materials machine components (B2) 
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TYPES OF DRAWINGS 

GRAPHIC LANGUAGE 

General  

A technical person can use the graphic language as powerful means of 
communication with others for conveying ideas on technical matters. However, for 
effective exchange of ideas with others, the engineer must have proficiency in (i) 
language, both written and oral, (ii) symbols associated with basic sciences and (iii) 
the graphic language. Engineering drawing is a suitable graphic language from which 
any trained person can visualise the required object. As an engineering drawing 
displays the exact picture of an object, it  obviously  conveys  the  same ideas to every 
trained eye. 

Irrespective of language barriers, the drawings can be effectively used in other 

countries, in addition to the country where they are prepared. Thus, the 
engineering drawing is the universal language of all engineers. 

Engineering drawing has its origin sometime in 500 BC in the regime of King 
Pharos of Egypt when symbols were used to convey the ideas among people. 

 

Importance of Graphic Language 

The graphic language had its existence when it became necessary to build new 
structures and create new machines or the like, in addition to representing the 
existing ones. In the absence of graphic language, the ideas on technical matters 
have to be conveyed by speech or writing, both are unreliable and difficult to 
understand by the shop floor people for manufacturing. This method involves not 
only lot of time and labour, but also manufacturing errors. Without engineering 
drawing, it would have been impossible to produce objects such as aircrafts, 

automobiles, locomotives, etc., each requiring thousands of different components. 

 

Need for Correct Drawings 

The drawings prepared by any technical person must be clear, unmistakable in 
meaning and there should not be any scope for more than one interpretation, or 
else litigation may arise. In a number of dealings with contracts, the drawing is an 
official document and the success or failure of a structure depends on the clarity of 
details provided on the drawing. Thus, the drawings should not give any scope for 
mis-interpretation even by accident. 

It would not have been possible to produce the machines/automobiles on a mass 
scale where a number of assemblies and sub-assemblies are involved, without clear, 
correct and accurate drawings. To achieve this, the technical person must gain a 
thorough knowledge  of both the principles and conventional practice of draughting. 
If these are not achieved and or practiced, the drawings prepared by one may convey 
different meaning to others, causing unnecessary delays and expenses in 
production shops. 
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Hence, an engineer should posses good knowledge, not only in preparing a correct 
drawing but also to read the drawing correctly. The course content of  this book is  
expected  to meet these requirements. 

The study of machine drawing mainly involves learning to sketch machine parts 

and to make working and assembly drawings. This involves a study of those 
conventions in drawings that are widely adopted in engineering practice. 

 

CLASSIFICATION OF DRAWINGS 

 
MACHINE DRAWING 

It is pertaining to machine parts or components. It is presented through a number of orthographic 

views, so that the size and shape of the component is fully understood. Part drawings and assembly 

drawings belong to this classification. An example of a machine drawing is given in Fig. 1.1. 

 

Fig 1.1: Machine Drawing 

 

Production Drawing 

A production drawing, also referred to as working drawing, should furnish all the dimensions, limits 

and special finishing processes such as heat treatment, honing, lapping, surface finish, etc., to guide 

the craftsman on the shop floor in producing the component. The title should also mention the 

material used for the product, number of parts required for the assembled unit, etc. 
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Since a craftsman will ordinarily make one component at a time, it is advisable to prepare the 

production drawing of each component on a separate sheet. However, in some cases the drawings 

of related components may be given on the same sheet. Figure 1.2 represents an example of a 

production drawing. 

 

Fig. 1.2 Production drawing 

Part Drawing 

Component or part drawing is a detailed drawing of a component to facilitate its manufacture. All 

the principles of orthographic projection and the technique of graphic representation must be 

followed to communicate the details in a part drawing. A part drawing with production details is 

rightly called as a production drawing or working drawing. 

Assembly Drawing 

A drawing that shows the various parts of a machine in their correct working locations is an 

assembly drawing (Fig. 1.3).  
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Fig 1.3 Assembly Drawing 

 

There are several types of such drawings. 

Design Assembly Drawing 

When a machine is designed, an assembly drawing or a design layout is first drawn to clearly 

visualise the performance, shape and clearances of various parts comprising the machine. 

Detailed Assembly Drawing 

It is usually made for simple machines, comprising of a relatively smaller number of simple parts. All 

the dimensions and information necessary for the construction of such parts and for the assembly 

of the parts are given directly on the assembly drawing. Separate views of specific parts in 

enlargements, showing the fitting of parts together, may also be drawn in addition to the regular 

assembly drawing. 
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Sub-assembly Drawing 

Many assemblies such as an automobile, lathe, etc., are assembled with many pre-assembled 

components as well as individual parts. These pre-assembled units are known as sub-assemblies. 

A sub-assembly drawing is an assembly drawing of a group of related parts, that form a part in a 

more complicated machine. Examples of such drawings are: lathe tail-stock, diesel engine fuel 

pump, carburettor, etc. 

Installation Assembly Drawing 

On this drawing, the location and dimensions of few important parts and overall dimensions of the 

assembled unit are indicated. This drawing provides useful information for assembling the machine, 

as this drawing reveals all parts of a machine in their correct working position. 

 Assembly Drawings for catalogues 

Special assembly drawings are prepared for company catalogues. These drawings show only the 

pertinent details and dimensions that would interest the potential buyer. Figure 1.4 shows a typical 

catalogue drawing, showing the overall and principal dimensions. 

 

Fig 1.4 Catalogue Drawings 
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Assembly Drawings for Instruction Manuals 

These drawings in the form of assembly drawings, are to be used when a machine, shipped away in 

assembled condition, is knocked down in order to check all the parts before reassembly and 

installation elsewhere. These drawings have each component numbered on the job. Figure 1.5 

shows a typical example of such a drawing. 

 

Fig 1.5 Assembly Drawing for Instruction Manuals 
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Exploded Assembly Drawing 

In some cases, exploded pictorial views are supplied to meet instruction manual requirements. 

These drawings generally find a place in the parts list section of a company instruction manual. 

Figure 1.6 shows drawings of this type which may be easily understood even by those with less 

experience in the reading of drawings; because in these exploded views, the parts are positioned in 

the sequence of assembly, but separated from each other. 

 

Fig 1.6 Exploded assembly drawing 

Schematic Assembly Drawing 

It is very difficult to understand the operating principles of complicated machinery, merely from the 

assembly drawings. Schematic representation of the unit facilitates easy understanding of its 

operating principle. It is a simplified illustration of the machine or of a system, replacing all the 

elements, by their respective conventional representations. Figure 1.7 shows the schematic 

representation of a gearing diagram. 
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Fig 1.7 Schematic Assembly Drawing 

Machine Shop Drawing 

Rough castings and forgings are sent to the machine shop for finishing operation (Fig. 1.8). Since 

the machinist is not interested in the dimensions and information of the previous stages, a machine 

shop drawing frequently gives only the information necessary for machining. Based on the same 

principle, one may have forge shop drawing, pattern shop drawing, sheet metal drawing, etc. 

 

Fig 1.8 Machine Shop Drawing 
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Patent Drawing 

When new machines or devices are invented, patent drawings come into existence, to illustrate and 

explain the invention. These are pictorial drawings and must be self-explanatory. It is essential that 

the patent drawings are mechanically correct and include complete illustrations of every detail of 

the invention. However, they are not useful for production purposes. The salient features on the 

drawing are numbered for identification and complete description. 

CONVENTIONAL REPRESENTATION 

Certain draughting conventions are used to represent materials in section and machine elements in 

engineering drawings. 

Materials 

As a variety of materials are used for machine components in engineering applications, it is 

preferable to have different conventions of section lining to differentiate between various 

materials. The recommended conventions in use are shown in Fig.1.9. 

 

Fig 1.9 Conventional representation of materials 
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Machine Components 

When the drawing of a component in its true projection involves a lot of time, its convention may 

be used to represent the actual component. Figure 1.10 shows typical examples of conventional 

representation of various machine components used in engineering drawing. 
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 DEPARTMENT OF MECHANICAL ENGINEERING    

 

Fig 1.10 Conventional representation of machine components 

DIMENSIONING 

A drawing of a component, in addition to providing complete shape description, must also furnish 

information regarding the size description. These are provided through the distances between the 

surfaces, location of holes, nature of surface finsih, type of material, etc. The expression of these 

features on a drawing, using lines, symbols, figures and notes is called dimensioning. 

General Principles 

Dimension is a numerical value expressed in appropriate units of measurement and indicated on 

drawings, using lines, symbols, notes, etc., so that all features are completely defined. 

1. As far as possible, dimensions should be placed outside the view. 

2. Dimensions should be taken from visible outlines rather than from hidden lines. 
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3. Dimensioning to a centre line should be avoided except when the centre line passes through 

the centre of a hole. 

4. Each feature should be dimensioned once only on a drawing. 

5. Dimensions should be placed on the view or section that relates most clearly to the 

corresponding features. 

6. Each drawing should use the same unit for all dimensions, but without showing the unit 

symbol. 

7. No more dimensions than are necessary to define a part should be shown on a drawing. 

8. No features of a part should be defined by more than one dimension in any one direction. 

Method of Execution 

The elements of dimensioning include the projection line, dimension line, leader line, dimension 

line termination, the origin indication and the dimension itself. The various elements of 

dimensioning are shown in Figs. 1.11. The following are some of the principles to be adopted during 

execution of dimensioning: 

 

 

Fig 1.11 Elements of dimensioning 
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1. Projection and dimension lines should be drawn as thin continuous lines. 

2. Projection lines should extend slightly beyond the respective dimension lines. 

3. Projection lines should be drawn perpendicular to the feature being dimensioned. Where 

necessary, they may be drawn obliquely, but parallel to each other (Fig. 1.12). However, they must 

be in contact with the feature. 

4. Projection lines and dimension lines should not cross each other, unless it is unavoidable (Fig. 

1.13). 

5. A dimension line should be shown unbroken, even where the feature to which it refers, is shown 

broken (Fig. 1.14). 

6. A centre line or the outline of a part should not be used as a dimension line, but may be used in 

place of projection line (Fig. 1.13). 

 

                 Fig 1.12     Fig 1.13    Fig 1.14 

 

 

 

 

 

 

 

 

 

 



 

 

PART A 

DRAWING OF MACHINE 
ELEMENTS AND PARTS 
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 SYLLABUS 
 

Part A: Drawing of Machine Elements and simple parts  

Selection of Views, additional views for the following machine elements and parts with every 
drawing proportion.  

1. Popular forms of Screw threads, bolts, nuts, stud bolts, tap bolts, set screws.  

2. Keys, cotter joints and knuckle joint.  

3. Rivetted joints for plates  

4. Shaft coupling, spigot and socket pipe joint.  

5. Journal, pivot and collar and foot step bearings.  
 

NOTE: 

1. First angle projection to be adopted. The student should be able to provide working drawings of 

actual parts. 

2. Part A need to be done by using AUTOCAD. 
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Course Objectives: 

CO2: To gain knowledge of conventional representation of various machining and mechanical 

details as per IS. 

CO3: To gain knowledge of threads, bolts, nuts, stud bolts, tap bolts, set screws, Keys, cottered 

joints and knuckle joint. 

CO4: To make part drawings including sectional views for various machine elements. 

 

Course Outcomes: 

 

1. Preparation of engineering and working drawings with dimensions and bill of material during design 
and development. Developing assembly drawings using part drawings of machine components.  

2. Conventional representation of materials, common machine elements and parts such as screws, nuts, 
bolts, keys, gears, webs, ribs.  

3. Types of sections – selection of section planes and drawing of sections and auxiliary sectional views. 
Parts not usually sectioned.  

4. Methods of dimensioning, general rules for sizes and placement of dimensions for holes, centers, 
curved and tapered features.  

5. Title boxes, their size, location and details - common abbreviations and their liberal usage. Types of 
drawings – working drawings for machine parts.  
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COURSE OUTLINE 

 

LECTURE LECTURE TOPIC KEY ELEMENTS LEARNING OBJECTIVES 

(2 to 3 objectives) 

1.  Screwed fasteners Popular forms of 
Screw threads, 
bolts, nuts, stud 
bolts, tap bolts, 
set screws. 

1. Remember the standard formulas 
of component (B1).  

2. Understand the how to draw a 
components (B2). 3.Apply the design 
formulas for components(B3) 

2.  Keys, cottered joints and 
knuckle joint 

i) Saddle keys, 
sunk keys 
ii) Cotter joint 
with sleeve, 
cotter joint with 
socket &spigot 
ends, cotter joint 
with a gib. 
iii)knuckle joint 

1. Remember the standard formulas 
of component (B1). 
2. Understand the how to draw a 
components (B2). 
3.Apply the design formulas for 
components(B3) 

3.  Rivetted joints  Plates 1. Remember the standard formulas 
of component (B1).  

2. Understand the how to draw a 
components (B2).  

3.Apply the design formulas for 
components(B3) 

4.  Shaft coupling, spigot and 
socket pipe joint 

Draw the 
different types of 
shaft couplings, 
Spigot and Socket 
pipe joints  

 

1. Remember the standard formulas 
of component (B1). 
2. Understand the how to draw a 
components (B2). 
3.Apply the design formulas for 
components(B3) 

5.  Bearings Journal, pivot 
and collar and 
foot step 
bearings 

1. Remember the standard formulas 
of component (B1).  
2. Understand the how to draw a 
components (B2). 
 3.Apply the design 
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INTRODUCTION TO AUTOCAD  

Computer-Aided Design(CAD) or Computer-Aided Design and Drafting (CADD) can be 

defined as using computer systems to assist in the creation, modification, analysis, or 

optimization of a design.  

 

CAD software is used to increase the productivity of the designer, improve the quality 

of design, improve communications through documentation, and create a database 

for manufacturing.  

 

CAD is an important industrial art extensively used in many applications, including 

automotive, shipbuilding, and aerospace industries, industrial and architectural 

design, prosthetics, and many more. (Pottmann, and et al., 2007) 

 

About AutoCAD 

 

AutoCAD is an industry-leading commercial CAD software. 

 

AutoCAD is used by AEC(Architecture, Engineer, and Construction) to generate and 

optimize 2D and 3D designs. AutoCAD is a widely used software program that can 

help you draft construction documentation, explore design ideas, visualize concepts 

through photorealistic renderings, and simulate how a design performs in the real 

world.  

 

AutoCAD was first released in December 1982 as a desktop app. In 2010, AutoCAD 

was released as a mobile- and web app, marketed as AutoCAD 360. 

 

 The Word AutoCAD is made up of two words “Auto(logo of company)”and CAD 

“(computer aided design)”.  

 AutoCAD is 2D and 3D modeling software.  

 It is developed by Autodesk company.  

 Autodesk is an U.S.A based company. 

  It is widely used in industry for 2D drawing and 3D modeling.  

 In another way we can say that AutoCAD is a designing course , which is performed 

by the help of computer. 
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VERSION OF AUTOCAD  

 AutoCAD software was firstly launched by Autodesk company in Dec. 1982.  

 It comes in India in 1988. T 

 The first version of AutoCAD was R1 after that R2,R3,R4…………… and so on.  

 In 2000,Autodesk launched a version of AutoCAD 2000 after that 2001,2002…… so 

on.  

USER INTERFACE 

 

Fig 1.15 User Interface 
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FUNCTION KEYS 

Key Feature Description 

F1  Help  Displays Help for the active tooltip, command, Palette or dialog 

box.  

F2  Expanded 

History  

Displays an expanded command history in the Command 

window  

F3  Object 

Snap  

Turns object snap ON and OFF  

F4  3D 

Object 

Snap  

Turns additional object snaps for 3D ON and OFF  

F5  Isoplane  Cycles through 2D isoplane settings (Top, Right and Left)  

F6  Dynamic 

UCS  

Turns automatic UCS alignment with planar surfaces ON and 

OFF  

F7  Grid 

display  

Turns the grid display ON and OFF  

F8  Ortho  Locks cursor movement to horizontal or vertical  

F9  Grid Snap  Restricts cursor movement to specified grid intervals 

F10  Polar 

Tracking  

Guides cursor movement to specified angles  

F11  Object 

Snap 

Tracking  

Tracks the cursor horizontally and vertically from object snap 

locations  

F12  Dynamic 

input  

Displays distances and angles near the cursor and accepts input 

as we use Tab between fields  
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STATUS BAR 

 

Fig 1.16 Status Bar 

 

Axes 

 

Fig 1.17 Axes 

 

COORDINATE SYSTEM 

There are 2 types of Coordinate System 

1. Absolute or Cartesian Coordinate System 

 Absolute coordinates refers to a Cartesian System that uses x-axis, y-axis, and 

sometimes a z-axis to establish a point some distance from a common origin. (x,y) 

2. Polar Coordinate System 

 The polar coordinate system is a two-dimensional coordinate system in which each 

point on a plane is determined by a distance from a reference point and an angle from a 

reference direction (r,θ) 
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Fig 1.18 Cartesian and Polar Coordinates 

 

1. Absolute Coordinate System 

• In the absolute coordinate system the points are located with respect to the origin 

(0,0). 

• The format for Absolute Coordinate System is (x,y) 

2. Relative Coordinate System 

• There are two types of relative coordinates 

a. Relative Rectangular Coordinates 

• In the relative coordinate system the points are located with respect to the last point 

drawn. 

• The format for Relative Rectangular Coordinates is @(x,y) 

b. Relative Polar Coordinates 

• In the relative polar coordinate system, a point can be located by defining both the 

distance of the point from the current point and the angle that the line between the 

two points makes with the positive X axis. 

• The format for Relative Rectangular Coordinates is @Distance < Angle 

Pan – P 

• The Pan command moves the observer and focus point relative to a fixed model 

position. Imagine that you are looking straight ahead and moving laterally left/right 

or up/down. The image will move opposite to the panning direction. ... Drag (left 
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click and hold) up or down, or arrow up or down, to pan up and down. 

 

Fig 1.19 Pan icon 

 

Zoom – Z 

• Increases or decreases the magnification of the view in the current viewport 

 

Fig 1.20 Zoom Tool bar 

 

DRAW TOOLBAR 

 

Fig 1.21 Draw Tool bar 

Commands 

1. Line – L 

2. Polyline – PL 

3. Circle – C 

4. Arc – A 

5. Rectangle – REC 

6. Ellipse – EL 

7. Polygon – POL 

8. Spline – SPL 
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9. Point – PO 

10. Hatch – H 

11. Multiline Text – MTEXT 

12. Block – B 

13. Write Block - WB 

MODIFY TOOLBAR 

 

Fig 1.22 Modify Toolbar 

Commands 

1. Erase – E 

2. Copy – CO 

3. Mirror – MI 

4. Offset – O 

5. Array – AR 

6. Move – M 

7. Rotate – RO 

8. Scale – SC 

9. Fillet – F 

10. Chamfer – CHA 

11. Trim – TR 

12. Extend – EX 

DIMENSIONING TOOLBAR 

 

Fig 1.23 Dimensioning Toolbar 
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Commands 

• Dimension – DIM 

• The commands for linear, aligned, angular, etc will be given as first DIM and then the 

respective command. 

• For example, 

• Linear – DIMLIN 

• Aligned – DIMALI 

• Angular – DIMANG 

 

LAYER TOOLBAR 

 

Fig 1.24 Layer Toolbar 

Layer - LA 

Other used Toolbars in AutoCAD are: 

• Format Menu 

Commands used are Dimension Style, Point Style, Text Style 

• Properties Tool Bar 

• Parametric Menu 

Commands used are Geometrical Constraints, Dimensional Constraints 
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SCREWED FASTENERS 

INTRODUCTION 

A machine element used for holding or joining two or more parts of a machine or 
structure is known as a fastener. The process of joining the parts is called fastening. 
The fasteners are of two types : permanent and removable (temporary). Riveting and 
welding processes are used for fastening permanently. Screwed fasteners such as 
bolts, studs and nuts in combination, machine screws, set screws, etc., and keys, 
cotters, couplings, etc., are used for fastening components that require frequent 
assembly and disassembly. 

Screwed fasteners occupy the most prominent place among the removable 
fasteners. In general, screwed fasteners are used : (i) to hold parts together, (ii) to 
adjust parts with reference to each other and (iii) to transmit power. 

SCREW THREAD NOMENCLATURE 

A screw thread is obtained by cutting a continuous helical groove on a cylindrical 
surface (external thread). The threaded portion engages with a corresponding 
threaded hole (internal thread); forming a screwed fastener. Following are the terms 
that are associated with screw threads (Fig. 2.1). 

 

 
Fig. 2.1 Screw thread nomenclature 

1. Major (nominal) diameter 

This is the largest diameter of a screw thread, touching the crests on an external thread or the roots 

of an internal thread. 

2. Minor (core) diameter 

This is the smallest diameter of a screw thread, touching the roots or core of an external thread 

(root or core diameter) or the crests of an internal thread. 
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3. Pitch diameter 

This is the diameter of an imaginary cylinder, passing through the threads at the points where 

the thread width is equal to the space between the threads. 

4. Pitch 

It is the distance measured parallel to the axis, between corresponding points on adjacent screw 

threads. 

5. Lead 

It is the distance a screw advances axially in one turn. 

6. Flank 

Flank is the straight portion of the surface, on either side of the screw thread. 

7. Crest 

It is the peak edge of a screw thread, that connects the adjacent flanks at the top. 

8. Root 

It is the bottom edge of the thread that connects the adjacent flanks at the bottom. 

9. Thread angle 

This is the angle included between the flanks of the thread, measured in an axial plane. 

FORMS OF THREADS 

Bureau of Indian Standards (BIS) adapts ISO (International Organisation for Standards) metric 

threads which are adapted by a number of countries apart from India. 

The design profiles of external and internal threads are shown in Fig. 2.2. The following are the 

relations between the various parameters marked in the figure : 
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Fig. 2.2 Metric screw thread 

 

P = Pitch  

H = 0.86 P 

d3 = d2 – 2 (H/2 – H/6) 

     = d – 1.22P 

D = d = Major diameter  

H1 = (D – D1)/2 = 5H/8 = 0.54P 

D2 = d2 = d – 0.75H  

h3 = (d – d3)/2 = 17/24H = 0.61P 

D1 = d2 – 2(H/2 – H/4) = d – 2H1 = d – 1.08P 

R = H/6 = 0.14P 

It may be noted from the figure that in order to avoid sharp corners, the basic profile is rounded 

at the root (minor diameter) of the design profile of an external thread. Similarly, in the case of 

internal thread, rounding is done at the root (major diameter) of the design profile. 

 

Other Thread Profiles 

Apart from ISO metric screw thread profile, there are other profiles in use to 

meet various applications. These profiles are shown in Fig. 2.3, the characteristics 

and applications of which are discussed below : 
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V-Thread (sharp) 

This thread profile has a larger contact area, providing more frictional resistance to 

motion. Hence, it is used where effective positioning is required. It is also used in 

brass pipe work. 

British Standard Whitworth (B.S.W) Thread 

This thread form is adopted in Britain in inch units. The profile has rounded ends, 

making it less liable to damage than sharp V-thread. 

Buttress Thread 

This thread is a combination of V-and square threads. It exhibits the advantages of 

square thread, like the ability to transmit power and low frictional resistance, with 

the strength of the V-thread. It is used where power transmission takes place in one 

direction only such as screw press, quick acting carpenter’s vice, etc. 

Square Thread 

Square thread is an ideal thread form for power transmission. In this, as the 

thread flank is at right angle to the axis, the normal force between the threads, acts 

parallel to the axis, with zero radial component. This enables the nut to transmit very 

high pressures, as in the case of a screw jack and other similar applications. 

ACME Thread 

It is a modified form of square thread. It is much stronger than square thread because 

of the wider base and it is easy to cut. The inclined sides of the thread facilitate quick 

and easy engagement and disengagement as for example, the split nut with the lead 

screw of a lathe. 

Worm Thread 

Worm thread is similar to the ACME thread, but is deeper. It is used on shafts to carry power 

to worm wheels

 

Fig. 2.3 Types of thread profiles 
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THREAD SERIES 

BIS recommends two thread series: coarse series and fine series, based on the relative values of the 

pitches. However, it must be noted that the concept of quality is not associated with these terms. 

For any particular diameter, there is only one largest pitch, called the coarse pitch and the rest are 

designated as fine pitches. 

Table 2.1 gives the nominal diameter and pitch combinations for coarse and fine series of ISO 

metric screw threads. 

Table 2.1 Diameter-pitch combination for ISO metric threads 
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THREAD DESIGNATION 

The diameter-pitch combination of an ISO metric screw thread is designated by the letter ‘M’ 

followed by the value of the nominal diameter and pitch, the two values being separated by the 

sign ‘×’. For example, a diameter pitch combination of nominal diameter 10 mm and pitch 1.25 

mm is designated as M10 × 1.25. 

If there is no indication of pitch in the designation, it shall mean the coarse pitch. For 

example, M 10 means that the nominal diameter of the thread is 10 mm and pitch is 1.5 mm. 

Following are the other designations, depending on the shape of the thread profile : 

SQ 40 × 10 – SQUARE thread of nominal diameter 40 mm and pitch 10 mm 

ACME 40 × 8 – ACME thread of nominal diameter 40 mm and pitch 8 mm 

WORM 40 × 10 – WORM thread of nominal diameter 40 mm and pitch 10 mm 

MULTI - START THREADS  

A single-start thread consists of a single, continuous helical groove for which the lead is equal to 

the pitch. As the depth of the thread depends on the pitch, greater the lead desired, greater will be 

the pitch and hence smaller will be the core diameter, reducing the strength of the fastener. To 

overcome this drawback, multi-start threads are recommended. 

Figure 2.4 shows single and double-start threads of V-and square profiles 

 

Fig. 2.4 Single and Multi-start threads 

In multi-start threads, lead may be increased by increasing the number of starts, without increasing 

the pitch. For a double start thread, lead is equal to twice the pitch and for a triple start thread, 

lead is equal to thrice the pitch. 

In double start threads, two threads are cut separately, starting at points, diametrically opposite to 

each other. In triple start threads, the starting points are 120° apart on the circumference of the 

screws. 

Multi-start threads are also used wherever quick action is desired, as in fountain pens, automobile 

starters, arbor press spindles, hydraulic valve spindles, etc. 
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RIGHT HAND AND LEFT HAND THREADS  

Screw threads may be right hand or left hand, depending on the direction of the helix. A right 

hand thread is one which advances into the nut, when turned in a clockwise direction and a left 

hand thread is one which advances into the nut when turned in a counter clockwise direction. An 

abbreviation LH is used to indicate a left hand thread. Unless otherwise stated, a thread should be 

considered as a right hand one. Figure 2.5 illustrates both right and left hand thread forms. 

 

Fig. 2.5 Right hand and left hand threads 

 

REPRESENTATION OF THREADS 

The true projection of a threaded portion of a part consists of a series of helices and it takes 

considerable time to draw them. Hence it is the usual practice to follow some conventional 

methods to represent screw threads. Figure 2.1 shows the true projection of a screw thread, 

whereas the conventional representation of external and internal threads as recommended by BIS 

is shown in Fig. 2.6. 

 
Fig. 2.6 Conventional representation of threads 



 DEPARTMENT OF MECHANICAL ENGINEERING    

The limit of useful length of screw threads is represented by a continuous thick line or a dotted line, 

depending on its visibility. The length upto which the incomplete threads are formed beyond the 

useful limit, is known as a run-out. It is represented by two inclined lines. 

 

The simplified representation, though it saves time, is not an effective method to convey thread 

forms. The schematic representation, used for the purpose is shown in Fig. 2.7. In practice, the 

schematic representation is followed for only visible threads, i.e., for external threads and internal 

threads in section. From the Fig. 2.7, it may be observed that the crest diameters, both in external 

and internal threads, are drawn by thick lines. Further, the crests are represented by thin lines, 

extending upto the major diameter and the roots by thick lines, extending upto the minor diameter, 

these lines being drawn inclined with a slope equal to half the pitch. 

 
Fig. 2.7 Schematic representation of threaded parts–V-threads 

 

Fig. 2.8 illustrates the schematic representation of square threads. 

 
Fig. 2.8 Schematic representation of threaded parts–Square threads 
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V-THREAD & SQUARE THREAD 

The simplified representation, though it saves time, is not an effective method to convey thread 

forms. The schematic representation, used for the purpose is shown in Fig. In practice, the schematic 

representation is followed for only visible threads, i.e., for external threads and internal threads in 

section. From the Fig. it may be observed that the crest diameters, both in external and internal 

threads, are drawn by thick lines. Further, the crests are represented by thin lines, extending up to the 

major diameter and the roots by thick lines, extending up to the minor diameter, these lines being 

drawn inclined with a slope equal to half the pitch 

 

BOLTED JOINT 

A bolt and nut in combination Fig. is a fastening device used to hold two Parts together. The body of 

the bolt, called shank is cylindrical in form, the head; square or hexagonal in shape, is formed by 

forging. Screw threads are cut on the other end of the shank. Nuts in general are square or hexagonal 

in shape. The nuts with internal threads engage with the corresponding size of the external threads of 
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the bolt.  However, there are other forms of nuts used to suit specific requirements. For nuts, 

hexagonal shape is preferred to the square one, as it is easy to tighten even in a limited Fig. Bolted 

joint space. This is because, with only one-sixth of a turn, the spanner can be re-introduced in the 

same position. However, square nuts are used when frequent loosening and tightening is required, for 

example on job holding devices like vices, tool posts in machines, etc. The sharp corners on the head 

of bolts and nuts are removed by chamfering 

Methods of Drawing Hexagonal (Bolt Head) Nut: 

 
Drawing hexagonal bolt head or nut, to the exact dimensions is laborious and time consuming. 

Moreover, as standard bolts and nuts are used, it is not necessary to draw them accurately. The 

following approximate methods are used to save the draughting time. 

(Fig. ) 

 

 

Empirical relations: 

Major or nominal diameter of bolt = D Thickness of nut, T = D 

Width of nut across flat surfaces, W = 1.5D + 3 mm 

Radius of chamfer, R = 1.5D 



 DEPARTMENT OF MECHANICAL ENGINEERING 

PROCEDURE: 

1. Draw the view from above by drawing a circle of diameter, W and 
describe a regular hexagon on it, by keeping any two parallel sides of  
the hexagon, horizontal. 

 
2. Project the view from the front, and the view from side, and mark the height equal to 

D. 

 
3. With radius R, draw the chamfer arc 2-1-3 passing through the point 1 in the front face. 

 
4. Mark points 4 and 5, lying in-line with 2 and 3.Locate points 8,9 on 

the top surface, by projecting from the view from above. 

 
5. Draw the chamfers 4–8 and 5–9. 

 

6. Locate points 6 and 7, lying at the middle of the outer two faces. 
 

7. Draw circular arcs passing through the points 
4, 6, 2 and 3, 7, 5, after determining the radius 
R1 geometrically. 

8. Project the view from the side and locate points 10, 11 and 12. 
 

9. Mark points 13 and 14, lying at the middle of the two faces (view from the side). 

 

10. Draw circular arcs passing through the points 10, 

13, 11 and 11, 14, 12, after determining the 

radius R2 geometrically. 

It may be noted that in the view from the front, the upper outer corners appear chamfered. 

In the view from the side, where only two faces are seen, the corners appear square. 

 

Method 2 (Fig.) 

Empirical relations: 

Major or nominal diameter of bolt = D Thickness of nut, T= D 

Width of the nut across corners= 2 D Radius of chamfer arc, R= 1.5 D 

Figure illustrates the stages of drawing different views of a hexagonal nut, following the above 

relations, which are self-explanatory. 
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The above method may be followed in routine drawing work, as it helps in drawing the views quickly. 

Method of Drawing Square (Bolt Head) Nut 

A square bolt head and nut may be drawn, showing either across flats or corners. Following relations 

may be adopted for the purpose: 

Major or nominal diameter of bolt =D 

Thickness of nut, T 

Width of the nut across flats, W      = 1.5 D + 3 mm 

Radius of chamfer arc, R          = 2 D 

 

 

 

 

 

 

Method of drawing the views of a square  

Figure shows the two views of a hexagonal headed bolt and square headed bolt, with the proportions marked. 
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Washers: 

A washer is a cylindrical piece of metal with a hole to receive the bolt. It is used to give a perfect 

seating for the nut and to distribute the tightening force uniformly to the parts under the joint. It also 

prevents the nut from damaging the metal surface under the joint. Figure shows a washer, with the 

proportions marked. Figure illustrates the views of a hexagonal headed bolt with a nut and a washer in 

position. 

Other Forms of Bolts: 

Square Headed Bolt with Square Neck: It is provided with a square neck, which fits into a 

corresponding square hole in the adjacent part, preventing the rotation of the bolt. 

 

T-Headed Bolt with Square Neck: 

In this, a square neck provided below the head, prevents the rotation of the bolt. This type of bolt is used 

for fixing vices, work pieces, etc., to the machine table having T-slots Fig. 

Hook Bolt: 

This bolt passes through a hole in one part only, while the other part is gripped by the hook shaped 

bolt head. It is used where there is no space for making a bolt hole in one of the parts. 

The square neck prevents the rotation of the bolt Fig 

D
 

Fig.Square headed bolt with square neck 
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Eye Bolt: 

In order to facilitate lifting of heavy machinery, like electric generators, motors, turbines, etc., eye 

bolts are screwed on to their top surfaces. For fitting an eye bolt, a tapped hole is provided, above the 

centre of gravity of the machine Fig. 

Cap Screws and Machine Screws : 

Cap screws and machine screws are similar in shape, differing only in their relative sizes. Machine 

screws are usually smaller in size, compared to cap screws. These are used for fastening two parts, 

one with clearance hole and the other with tapped hole. The clearance of the unthreaded hole need 

not be shown on the drawing as its presence is obvious. Figure 

0
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 D
 

2
 D
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  2 D 

1
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                        5.24 shows different types of cap and machine screws, with proportions marked 

The bolted joints, though removable in nature, are required to stay firm without becoming loose, of 

their own accord. However, the joints used in the moving parts of machinery, may be subjected to 

vibrations. This may slacken the joint, leading to serious breakdown. To eliminate the slackening 

tendency, different arrangements, as discussed further, are used to lock the nuts: 

LOCK NUT: 

This is the most commonly used locking device. In this arrangement, a second nut, known as lock nut 

is used in combination with a standard nut Fig. The thickness of a lock nut is usually two-thirds D, 

where D is the major diameter of the bolt. The lock nut is usually placed below the standard nut. To 

make the joint, the lock nut is first screwed tightly and then the standard nut is tightened till it touches 

the lock nut. Afterwards, the locknut is then screwed back on the standard nut, which is held by a 

spanner. The threads of the two nuts become wedged between the threads of the bolt. 
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LOCKING BY SPLIT PIN 

A split pin is inserted through a hole in the bolt body and touching just the top surface of the nut. 
Then, the ends of the pin are split open to prevent it from coming out while in use Fig. 
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WILE’S LOCK NUT 

It is a hexagonal nut with a slot, cut half-way across it. After tightening the nut in the usual manner, a 

set screw is used from the top of the nut, compressing the two parts. For this purpose, the upper 

portion of the nut should have a clearance hole and the lower portion tapped Fig. 

LOCKING BY SET SCREW 

In this arrangement, after the nut is tightened, a set screw in fitted in the part, adjoining the nut, so 

that it touches one of the flat faces of the nut. The arrangement prevents the loosening tendency of 

the nut Fig 

GROOVED NUT 

It has a cylindrical grooved collar, integrally provided at the lower end of the nut. This collar fits into a 

corresponding recess in the adjoining part. In this arrangement, after tightening the nut, a set screw is 

inserted from one end of the upper part, so that the end of the set screw enters the groove, 

preventing the loosening tendency of the nut Fig. 

LOCKING BY SCREW 

In this, a cap nut with an integral washer and with a threaded hole in the cylindrical cap, is used. A 

corresponding tapped hole at the top end of the bolt is also required for the purpose. In this 

arrangement, a set screw fitted through the cap and through the bolt end, prevents the loosening 

tendency of the nut, when the pitches of the main nut and the set screw are different Fig. This type of 

arrangement is used for fitting the propeller blades on turbine 

 

 

 

 



 DEPARTMENT OF MECHANICAL ENGINEERING 

LOCKING BY PLATE 

A locking plate is grooved such that it fits a hexagonal nut in any position, at intervals of 30°  of rotation. It is 

fixed around the nut, by means of a machine screw, as shown in Fig. 

LOCKING BY SPRING WASHER 

In this arrangement, a spring washer of either single or double coil is placed under the nut and 

tightened. The spring force of the washer will be acting upwards on the nut.  

FOUNDATION BOLTS: 

Foundation bolts are used for fixing machines to their foundations. Foundation bolts are made by 

forging from mild steel or wrought iron rods. The bolt size depends upon the size of the machine and 

the magnitude of the forces that act on them when the machine is in operation. 

For setting the bolts in position, their positions are marked and then suspended in the holes made in 

the ground. Afterwards, cement concrete is filled in the space around in the bolt. 

EYE FOUNDATION BOLT 

This is the simplest form of all foundation bolts. In this, one end of the bolt is forged into an eye and a 

cross piece is fixed in it. Figure shows an eye foundation bolt that is set in concrete. 

BENT FOUNDATION BOLT 

As the name implies, this bolt is forged in bent form and set in cement concrete. When machines are 

to be placed on stone beds, the bolts are set in lead. Figure shows a bent foundation bolt that is set 

first in lead and then in cement concrete, resulting in a firm and stable bolt. 

RAG FOUNDATION BOLT 

This bolt consists of a tapered body, square or rectangular in cross-section, the tapered edges being 

grooved. Figure shows a rag foundation bolt that is set first in lead and then in cement concrete. 
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Fig:   Eye foundation bolt Fig: Bent foundation bolt 

  LEWIS FOUNDATION BOLT 

 
This is a removable foundation bolt. The body of the bolt is tapered in width on one side. To use this bolt, a pit 

is produced in cement concrete, by using a (foundation) block. Once the concrete sets-in, the bolt is placed in it 

so that the tapered bolt surface, bears against the tapered face of the pit. A key is then inserted, bearing 

against the straight surfaces of the pit and the bolt. This arrangement makes the bolt firm in the bed. However, 

the bolt may be removed by withdrawing the key. This type of foundation bolt is not commonly used for fixing 

machines. 
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COTTER FOUNDATION BOLT  

It is used for fixing heavy machines. It has a rectangular slot at its bottom end, to receive a cotter. For putting 

the bolts in position, the foundation bed is first made, providing holes for inserting cotters. Figure shows a 

cotter foundation bolt in position. A cast iron washer (W) placed as shown, provides bearing surface for the 

cotter (C). 

 

KEYS, COTTERS AND PIN JOINTS 

INTRODUCTION 

Keys, cotters and pin joints discussed in this chapter are some examples of removable (temporary) 

fasteners. Assembly and removal of these joints are easy as they are simple in shape. The standard 

proportions of these joints are given in the figures. 
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KEYS 

Keys are machine elements used to prevent relative rotational movement between a shaft and the 

parts mounted on it, such as pulleys, gears, wheels, couplings, etc. Figure shows the parts of a keyed 

joint and its assembly. 

Hollow Saddle Key 

A hollow saddle key has a concave shaped bottom to suit the curved surface of the shaft, on which it 

is used. A keyway is made in the hub of the mounting, with a tapered bottom surface. When a hollow 

saddle key is fitted in position, the relative rotation between the shaft and the mounting is prevented 

due to the friction between the shaft and key 

Flat Saddle Key 

It is similar to the hollow saddle key, except that the bottom surface of it is flat. Apart from the tapered keyway 

in the hub of the mounting, a flat surface provided on the shaft is used to fit this key in position. 
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Sunk keys may be classified as: 

 

(i) Taper keys, (ii) parallel or feather keys and (iii) woodruff keys. 

Fig:Flat Saddle Key 

 

Fig. Key with gib 

Head Following are the proportions for a gib head 

Width of head, B= 1.5 T If D is the diameter of the shaft, then,  

Width of key, W= 0.25 D + 2 mm 

Thickness of key, T= 0.67 W (at the thicker end) 

 Standard taper = 1:100 
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Height of head, H= 1.75 T 

Parallel or Feather Keys 

A parallel or feather key is a sunk key, uniform in width and thickness as well. These keys are used when the 

parts (gears, clutches, etc.) 

fig: Parallel sunk key 

The feather key may be fitted into the keyway provided on the shaft by two or more screws Fig. or into the hub 

of the mounting Fig. As seen from Fig., these keys are of three types: (i) peg feather key, (ii) single headed 

feather key and (iii) double headed feather key 

 

Peg Feather Key: 

 
In this key, a projection known as peg is provided at the middle of the key. The peg fits into a hole in the hub of 

the sliding member (Fig. a). Once placed in a position, the key and the mounting move axially as one unit. 
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Single Headed Feather Key: 

In this, the key is provided with a head at one end. The head is screwed to the hub of the part mounted on the 

shaft (Fig. b). 

Double Headed Feather Key: 

In this, the key is provided with heads on both ends. These heads prevent the axial movement of the key in the 

hub. Here too, once placed in position, the key and the mounting move as one unit (Fig. c). 

Woodruff Key: 

It is a sunk key, in the form of a segment of a circular disc of uniform thickness. As the bottom surface of the 

key is circular, the keyway in the shaft is in the form of a circular recess to the same curvature as the key. 

 

Fig:Woodruff 

Key If D is the diameter of the shaft, 

Thickness of key, W = 0.25 D 

Diameter of key, d = 3 W 

Height of key, T = 1.35 W 

Depth of the keyway in the hub, T1 = 

0.5 W + 0.1 mm 

 Depth of keyway in shaft, T2 = 

0.85 W 

Round Keys: Round keys are of circular cross-section, usually tapered (1:50) along the length. A round key fits 

in the hole drilled partly in the shaft and partly in the hub Fig.The mean diameter of the pin may be taken as 

0.25 D, where D is shaft diameter. Round keys are generally used for light duty, where the loads are not 

considerable. 
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 Fig:Round key 

COTTER JOINTS: 

Cotter joints are used to connect two rods, subjected to tensile or compressive forces along their axes. These 

joints are not suitable where the members are under rotation. The following are some of the commonly used 

cotter joints: 

Cotter Joint with Sleeve: 

This is the simplest of all cotter joints, used for fastening two circular rods. To make the joint, the rods are 

enlarged at their ends and slots are cut. After keeping the rods butt against each other, a sleeve with slots is 

placed over them. After aligning the slots properly, two cotters are driven-in through the slots, resulting in the 

joint Fig 

Fig.  Cotter joint with sleeve 
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Cotter Joint with Socket and Spigot Ends 

 
This joint is also used to fasten two circular rods. In this, the rod ends are modified instead of using a 

sleeve. One end of the rod is formed into a socket and the other into a spigot Fig. and slots are cut. 

After aligning the socket and spigot ends, a cotter is driven-in through the slots, forming the joint. 

 

 

 

 

 

 

Cotter Joint with a Gib 

This joint is generally used to connect two rods of square or rectangular cross-section. To make the joint, one 

end of the rod is formed into a U-fork, into which, the end of the other rod fits in. When a cotter is driven-in, 

the friction between the cotter and straps of the U-fork, causes the straps to open. This is prevented by the use 

of a gib. 

 

PIN JOINTS: In a pin joint, a pin is used to fasten two rods that are under the action of a tensile force; although 

the rods may support a compressive force if the joint is guided. Some pin joints such as universal joints use two 

pins and are used to transmit power from one rotating shaft to another. 

Fig. Cotter joint with socket and spigot ends 

D D D 

5 
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Knuckle Joint: A knuckle joint is a pin joint used to fasten two circular rods. In this joint, one end of the rod is 

formed into an eye and the other into a fork (double eye). For making the joint, the eye end of the rod is 

aligned into the fork end of the other and then the pin is inserted through the holes and held in position by 

means of a collar and a taper pin (Fig). Once the joint is made, the rods are free to swivel about the cylindrical 

pin. 

 

Fig.  Knuckle joint 

 

SHAFT COUPLINGS 

INTRODUCTION 

Shaft couplings are used to join or connect two shafts in such a way that when both the shafts rotate, 

they act as one unit and transmit power from one shaft to the other. Shafts to be connected or 

coupled may have collinear axes, intersecting axes or parallel axes at a small distance. Based on the 

requirements, the shaft couplings are classified as: (i) rigid couplings, (ii)flexible couplings, (iii) loose or 

dis-engaging couplings and (iv) non-aligned couplings. 

Rigid Couplings 

Rigid shaft couplings are used for connecting shafts having collinear axes. These are further sub-

classified into muff or sleeve couplings and flanged couplings. 

Sleeve or Muff Couplings 

This is the simplest of all couplings. It consists of a sleeve called muff, generally made of cast iron, 

which is fitted over the ends of the shafts to be connected. After properly aligning the keyways in the 
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shafts and sleeve, a sunk key is driven-in; thus making the coupling. Instead of a single key running the 

entire length of the sleeve, it is desirable to use two keys, which may be inserted from the outer ends 

of the sleeve; thus overcoming the possible miss-alignment between the keyways. The following are 

the types of muff couplings: 

Butt-muff Coupling 

In this, the ends of the two shafts to be coupled butt against each other, with the sleeve keyed to 

them, as discussed above. 

Half-lap Muff Coupling 

In this, the ends of the shafts overlap each other for a short length. The taper provided in the overlap 

prevents the axial movement of the shafts. Here too, after placing the muff over the overlapping ends 

of the shafts, a saddle key(s) is(are) used to make the coupling. 

Split-muff Coupling 
In this, the muff is split into two halves and are recessed. A number of bolts and nuts are used to 
connect the muff halves and the recesses provided accommodate the bolt 

 

Fig. Butt-muff coupling 

 

 Fig. Half-lap 
muff coupling 
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Fig. Split-muff coupling 
Flanged Couplings: 

These are the standard forms of couplings, most extensively used. In a flanged coupling, flanges are 

either fitted or provided at the ends of shafts. The flanges are fastened together by means of a 

number of bolts and nuts. The number and size of the bolts depend upon the power to be transmitted 

and hence, the shaft diameter. 

Flanged Coupling with Detachable Flanges 

In this, two flanges are keyed, one at the end of each shaft, by means of sunk keys. For ensuring 

correct alignment, a cylindrical projection may be provided on one flange which fits into the 

corresponding recess in the other. 

Solid Flanged Coupling 

Couplings for marine or automotive propeller shafts demand greater strength and reliability. For these 

applications, flanges are forged integral with the shafts. The flanges are joined together by means of a 

number of headless taper bolts. 

 

Fig. Flanged coupling 
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Fig. Protected flanged coupling 
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Fig. Solid flanged coupling 
 

Compression Coupling:This consists of a compressible steel sleeve which fits on to the ends of the 

shafts to be coupled. The sleeve corresponds to the shaft diameter and its outer surface is of double 

conical form. The sleeve has one through cut longitudinally and five other cuts, equip-spaced, but 

running alternately from opposite ends to about 85% of its length; making it radially flexible.  

Claw Coupling 

In this, each flange has a number of identical claws which engage into the corresponding recesses in 

the flange. One flange is firmly fitted to the driving shaft by means of a taper sunk key. The other one 

is placed over the driven shaft by two feather keys, so that it can slide freely on it. The sliding flange 

has a groove on the boss, into which the forked end of a lever fits. 

 

Fig. Claw coupling 

Cone Coupling 
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In this, two shafts may be coupled together by means of two flanges with conical surfaces (on the 

inside of one and on the outside of the other) by virtue of friction. Here too, one flange is firmly fitted 

to the driving shaft by means of a taper sunk key, whereas the other slides freely over a feather key 

fitted to the driven shaft. 

 

Fig. Cone coupling 

 
Universal Coupling (Hooke’s Joint): 

It is a rigid coupling that connects two shafts, whose axes intersect if extended. It consists of two forks 

which are keyed to the shafts. The two forks are pin joined to a central block, which has two arms at 

right angle to each other in the form of a cross. The angle between the shafts may be varied even 

while the shafts are rotating. 
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Oldham Coupling 

It is used to connect two parallel shafts whose axes are at a small distance apart. Two flanges, each 

having a rectangular slot, are keyed, one on each shaft. The two flanges are positioned such that, the 

slot in one is at right angle to the slot in the other. 

 

 

Socket and Spigot Joint: 

This type of joint is used for underground pipelines of large diameters. In this, one end of a pipe is 

made into a socket and the other end into a spigot. After placing the spigot end into the socket, the 

space between them is filled-in, partly by rope (jute or coir) and the remaining by molten lead. 

Because of the flexible nature of the joint, it adapts itself to small changes in level due to settlement 

of earth 

 

Fig. Socket and spigot joint 
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RIVETTED JOINTS FOR PLATES 

INTRODCTION 

Riveted joints are permanent fastenings and riveting is one of the commonly used method of 

producing rigid and permanent joints. Manufacture of boilers, storage tanks, etc., involve joining of 

steel sheets, by means of riveted joints. These joints are also used to fasten rolled steel sections in 

structural works, such as bridge and roof trusses. 

Rivet 

A rivet is a round rod of circular cross-section. It consists of two parts, viz., head and shank (Fig.(a)). 

Mild steel, wrought iron, copper and aluminum alloys are some of the metals commonly used for 

rivets. The choice of a particular metal will depend upon the place of application. 

Riveting 

Riveting is the process of forming a riveted joint. For this, a rivet is first placed in the hole drilled 

through the two parts to be joined. Then the shank end is made into a rivet head by applying pressure, 

when it is either in cold or hot condition. 

 

Fig.(a) Rivet (b) Riveting 
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RIVET HEADS: Various forms of rivet heads used in general engineering works and boiler construction 

and as recommended by Bureau of Indian Standards,are shown in Fig. The standard proportions are also 

indicated in the figure.                                                                  Fig.Types of rivet  heads 

 

Diamond Butt Joint: 

This is one kind of butt joint made either with a single or double strap. As the name implies, the rivets 

in this joint are arranged in a diamond shape. Figure shows a double strap diamond butt joint. The 

joint is generally used to connect tie bars in bridge structures and roof trusses 
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Fig: Double strap diamond butt joint 
Lap Joints: 

In a lap joint, the plates to be riveted overlap each other. The plates to be joined are first bevelled at 

the edges, to an angle of about 80°. Depending upon the number of rows of rivets used in the joint, 

lap joints are further classified as single riveted lap joint, double riveted lap joint and so on. 

In mult i-row rivetedt    joints, rows may be arranged either in chain or zig-zag fashion, as shown in Figs. 

Figure shows a single riveted lap joint. The size of the rivet, d is taken as, d = 6mm 

Where’s’ is the thickness of the plates to be joined in millimeters. 

 

Fig. Single riveted lap joint 
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Fig. Double riveted chain lap joint 
 

 

 

 

Fig. Double riveted zig-zag lap joint 
 

Butt Joints: 

In a butt joint, the plates to be joined butt against each other, with a cover plate or strap, either on 

one or both sides of the plates; the latter one being preferred. In this joint, the butting edges of the 

plates to be joined are square and the outer edges of the cover plate(s) is (are) beveled. 
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In a single strap butt joint, the thickness of the strap (cover plate) is given by, t1 = 1.125t If two straps 

are used, the thickness of each cover plate is given by, t2 = 0.75t 

 

Fig. Single riveted, single strap butt joint 

 

Fig. Single riveted, double strap butt joint 
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Fig. Double riveted, double strap chain butt joint 
 

 

 

Fig.Double riveted, double strap zig-zag butt joint 
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Pivot or Foot-step bearing: 

This bearing is used to support a vertical shaft under axial load. Further, in this, the shaft is terminated 

at the bearing. The bottom surface of the shaft rests on the surface of the bearing which is in the form 

of a disc. The bush fitted in the main body supports the shaft in position and takes care of possible 

radial loads coming on the shaft. 

 

Fig. Foot-step bearing 
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Industrial Application of screw fasteners 

 Military – Fasteners specially designed to withstand the stress of high temperature, high wear and 

corrosive environments such as engines, motors, heat exchangers and process equipment.  We 

offer a wide range of diameters, lengths and thread configurations using stainless steel, copper 

alloys, alloy steels, nickel alloys and exotic alloys. 

 Oilfield – Fasteners manufactured using stainless steel, tool alloys, nickel alloys and exotic metals 

that will perform well in the high stress, corrosive environment found in oilfield and mining 

applications. Our fasteners are used in drilling rigs, tanks and pumping equipment. 

 Turbine & Power Generation – Fasteners used in electrical equipment, turbines, motors, exhaust 

systems, pumping systems and storage vessels.  Nickel alloys, aluminum, steel alloys and stainless 

steel are used for their strength, high wear and anti-corrosive properties.  Copper alloys are used 

for their conductive properties. 

 

 

 

http://www.boltman.com/stainless-steel.html
http://www.boltman.com/copper-alloys.html
http://www.boltman.com/copper-alloys.html
http://www.boltman.com/nickel-alloys.html
http://www.boltman.com/exotics.html
http://www.boltman.com/copper-alloys.html
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Riveted joints in Boilers: 

 

 

 

 

Coupling 
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BEARINGS 
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Tutorial Questions: 

1. Draw the conventional representation of  following materials 

(a) Porcelain     (b) Fiber    (c) Lead    (d) Petrol     (e) Copper 

2. Draw the single riveted single strap Butt joint of plate thickness as 12 mm . 

      Draw the half-sectional front view and side view of journal bearing which can accommodate 40 mm   

     diameter shaft. 

4. Draw the three views of a hexagonal headed bold of nominal diameter 20 mm and length 80 mm with a     

     hexagonal nut and washer. 

5. Draw the conventional representation of the following materials. 

(a) Cast iron (b) Lead (c) marble (d) glass (e) water (f) concrete (g) wood 

    Draw the sectional front view and top view of a double riveted double strap chain Butt Joint to joint two plates     

    of thickness 10 mm 

6. Draw the sectional front, top and side view of a knuckle joint to join two rods of diameter 30 mm each.   

7. Draw the three views of a hexagonal headed bold of nominal diameter 20 mm and length 80 mm with a  

     hexagonal nut and washer. 

8.Draw the sectional front view of a universal coupling joining two shafts of diameter 50 mm. Show the   

   dimensions. 

9. Draw the sectional view from the front and top view of a single riveted single strap butt joint with plates of    

    thickness 15 mm. 

10. Sketch the sectional front view of rag foundation bolt of diameter 25 mm. Show the proportionate  

     dimensions in the drawing 
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Question bank for Assignments 

1 .Answer the following: 

    Sketch a (i) Hexagonal nut convention, (ii) Convention of a stud bolt. 

2. Sketch the conventional representation of Square headed bolt ii. Keys. 

3. Sketch the conventional representation of 

     i) Hexagonal bolt ii) Shaft.  Iii). Mention the importance of list of materials. 

4. Sketch the conventional representation of i) Eye bolt ii.) Foundation bolt. 

5. Answer the following: 

    Sketch conventional representation of the materials steel and Lead 

6. Sketch the following: Whit worth thread and Buttress thread. 

7. Show the conventional representation of the following materials: 

   i) Wood ii. Lead iii. Straight Knurling iv. Internal screw threads v Bearing on shafts. 

8. Sketch the conventional representation of the various materials. 

Sketch the conventional representation of the different engineering materials. 

9. Draw the triple start square threads with D as 30 mm. 

10. Draw sectional front view and side view of Cotter joint with socket and spigot ends taking d=30 mm. 

11. Draw sectional front view and top view of double riveted, zig zag joint with dia of rivet as 10 mm. 

12. Draw two views of locking the nut with set screw if D= 30mm. 

13. Draw sectional front view and side view of the Cotter Joint with a gib of 40 square. 

14. Draw sectional front view and top view of double riveted, zig zag joint with dia of rivet as 10 mm. 

15. Draw two views of hexagonal headed bolt and nut and square headed bolt along with nut. (D=30mm). 

16. Draw two views of hexagonal headed bolt and nut and square headed bolt along with nut. (D=30mm). 

17. Draw the sectional front view and top view of the double riveted double strap zig zag butt joint with dia of 

the rivet as 14 mm. 

18. Draw at least four types of thread profiles taking pitch as 20 mm. 

19. Draw sectional front view and side view of Cotter joint with socket and spigot ends taking d=30 mm. 
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20. Answer any Two of the following by drawing proportionate diagrams: 

Single riveted, double strap butt joint for plates of 12 mm thickness with cover plate thickness of 10 mm 

ii.. Mu coupling to connect two shafts of 50mm diameter. 

iii. Foot step bearing for a shaft of 75 mm diameter. 

21. Answer any Two of the following by drawing proportionate diagrams 

Triple riveted single strap zig-zag butt joint to connect two plates of 12mm thick. 

Flange coupling to connect to shafts of 20 mm diameter. 

22. Answer any Two of the following by drawing proportionate diagrams 

Triple riveted single strap zig-zag butt joint to connect two plates of 12mm thick. 

Flange coupling to connect to shafts of 20 mm diameter. 

23. Answer any Two of the following: 

Draw plan and sectional elevation of a chain type double - riveted lap joint. Take the diameter of rivet as 18 

mm. 

Sketch a Knuckle joint showing sectional front view and top view to connect two rods of 40 mm diameter. 

Draw half sectional view from the front and side view of a mu coupling to connect two shafts of 30 mm 

diameter. 

24. Answer any Two of the following: 

Draw front view with top half in section and side view of a socket and spigot type of cotter joint to connect two 

rods of 25 mm diameter each. 

Draw sectional front view and top view of double riveted, double cover butt joint, zig-zag riveting to join plates 

of thickness 16 mm. 

Draw proportionately a hexagonal bolt with nut. Take the diameter of the bolt as 25 mm . 

25. Answer any Two of the following: 

26. Draw half sectional view from the front and side view of a flange coupling to connect two shafts of 25 mm 

diameter. 

27. Draw plan and sectional elevation of double riveted lap joint, chain riveting, taking 12mm diameter rivet. 

28. Draw half sectional front view and side view of a foot step bearing for 40 mm diameter. 
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29. Answer any Two of the following: 

i. Draw plan and sectional elevation of a double – riveted lap joint (chain riveting) taking diameter of rivet as 20 

mm. 

ii.Sketch two views of cotter joint with a gib to connect two square rods of side 30 mm with proper dimensions. 

iii.Draw half sectional front view and side view of a rigid flange coupling to connect two shafts of 30 mm 

diameter. 

30. Draw two views of knuckle joint with properties to connect two shafts of 25 mm diameter. 

31. Draw single strap butt joint of two rows zigzag to connect two plates of 5 mm thick. 

32. Draw protected flange coupling to connect two shafts of 50 mm diameter. 

33. Draw spigot and socket type of pipe joint to connect 30 mm diameter pipes. 

34. Draw double riveted lap joint zigzag type to join 15mm plates. 

35. Draw flexible flanged coupling to join two shafts of 100 mm diameter. 

36. Draw a footstep bearing for a shaft of 150 mm diameter. 

37. Draw a collar bearing to a shaft of 50 mm diameter. 

38. Draw a sleeve and cotter joint to connect two shafts of 30 mm diameter. 

39. Draw a triple riveted single strap butt joint to connect two plates of 15 mm thickness. 

40. Draw a Plummer block for a shaft of 25 mm diameter. 

41. Draw a double riveted double strap chain type butt joint to connect plates of 20 mm size. 

42. Sketch square headed bolt with a nut and washer 

43. Draw two views of knuckle joint with properties to connect two shafts of 25mm diameter. 

44. Draw single strap butt joint of two rows zigzag to connect two plates of 5mm thick 

45. Draw spigot and socket type of pipe joint to connect 30 m diameter pipes 

 

 



 

 

SECTION B 

ASSEMBLY DRAWINGS 
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 SYLLABUS 
 

Part B: Assembly Drawings of assembled views for the part drawings of the following using 

conventions and easy drawing proportions. 

1. Steam engine parts – stuffing boxes, cross heads, Eccentrics. 

2. Machine tool parts: Tail stock, Tool Post, Machine Vices. 

3. Other machine parts - Screws jacks, Petrol engine connecting rod, Plummer block, Fuel Injector 

4. Valves - Steam stop valve, spring loaded safety valve, feed check valve and air cock. 

NOTE: 

1. First angle projection to be adopted. The student should be able to provide working drawings of 

actual parts. 

2. Part B need to be done by using Creo. 
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Course Objectives: 

CO5: To prepare assembly drawings given the details of part drawings. 

 

Course Outcomes: 

1. Developing assembly drawings using part drawings of machine components. 

 

 

COURSE OUTLINE 

LECTURE LECTURE TOPIC KEY ELEMENTS LEARNING OBJECTIVES 

(2 to 3 objectives) 

1.  Steam engine parts Stuffing boxes, 
cross heads, 
Eccentrics 

1. Understand the PART drawing of 
assembly components (B2).  

2.Apply the assembly procedure (B3) 

2.  Machine tool parts Tail stock, Tool 
Post, Machine 
Vices 

1. Understand the PART drawing of 
assembly components (B2).  
2.Apply the assembly procedure (B3) 

3.  Other machine parts  Screws jacks, 
Petrol engine 
connecting rod, 
Plummer block, 
Fuel Injector 

1. Understand the PART drawing of 
assembly components (B2).  
2.Apply the assembly procedure (B3) 

4.  Valves  Steam stop valve, 
spring loaded 
safety valve, feed 
check valve and 
air cock  

1. Understand the PART drawing of 
assembly components (B2).  
2.Apply the assembly procedure (B3) 
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INTRODUCTION TO ASSEMBLY DRAWINGS 

A machine is an assembly of various links or parts. It is necessary to understand the relation 

between the various parts of the unit for the purpose of design and production. 

An assembly drawing is one which represents various parts of a machine in their working position. 

These drawings are classified as design assembly drawings, working assembly drawings, sub-

assembly drawings, installation assembly drawings, etc. An assembly drawing made at the design 

stage while developing a machine is known as design assembly drawing. It is made to a larger scale 

so that the required changes or modifications may be thought of by the designer, keeping in view 

both the functional requirement and aesthetic appearance. Working assembly drawings are 

normally made for simple machines, comprising small number of parts. Each part is completely 

dimensioned to facilitate easy fabrication. A sub-assembly drawing is an assembly drawing of a 

group of related parts which form a part of a complicated machine. Thus, a number of such sub-

assembly drawings are needed to make a complete unit. An installation assembly drawing reveals 

the relation between different units of a machine, giving location and dimensions of few important 

parts. 

The final assembly drawings are prepared from design assembly drawings or from the working 

drawings (component drawings). The class-room exercises are designed to train the students to 

master fundamentals of machine drawing, such as principles of drawing, orthographic projections, 

etc. In addition, the student will understand the relation between the different parts of the 

components and working principles of the assembled unit. The following steps may be made use of 

to make an assembly drawing from component drawings: 

1. Understand the purpose, principle of operation and field of application of the given 

machine. This will help in understanding the functional requirements of individual parts and their 

location. 

2. Examine thoroughly, the external and internal features of the individual parts. 

3. Choose a proper scale for the assembly drawing. 

4. Estimate the overall dimensions of the views of the assembly drawing and make the outline 

blocks for each of the required view, leaving enough space between them, for indicating 

dimensions and adding required notes. 

5. Draw the axes of symmetry for all the views of the assembly drawing. 

6. Begin with the view from the front, by drawing first, the main parts of the machine and then 

adding the rest of the parts, in the sequence of assembly. 

7. Project the other required views from the view from the front and complete the views. 

8. Mark the location and overall dimensions and add the part numbers on the drawing. 
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9. Prepare the parts list. 

10. Add the title block. 

NOTE It is not advisable to complete one view before commencing the other. The better method is 

to develop all the required views simultaneously. 

 

INTRODUCTION TO CREO 

Creo Parametric is one of the most powerful Computer-Aided Design (CAD), Computer-Aided 

Analysis and Computer-Aided Manufacture (CAM) software packages available in the world today. 

It is the flagship of a family of other software products, developed by PTC Corporation, for 

engineering design and product development, also including Creo Direct, Creo Simulate, Creo 

Layout and others. The main applications are in mechanical, product design, aerospace, 

construction, shipbuilding and other industries. 

Creo Parametric (or Creo) was previously known as Pro/Engineer and Wildfire. The core of the 

software contains a variety of tools for the creation, validation and communication of complex 

three-dimensional (3D) objects as parts and assemblies. In addition, there are integrated 

applications that associate directly with the 3D model geometry and support the development of 

engineering drawings, mould design, NC machine simulation, sheet metal design, piping and wiring, 

harness design, structural strength, thermal and CFD analyses, kinematic and dynamic analyses, 

feasibility and optimisation studies, and others. This long list of applications is not meant to scare 

the user but only to illustrate the vast scope and complexity of a modern CAD/CAM package. 

For designers who are involved in several parts of product development, Creo offers them scalable 

access to the right capabilities. At the same time, for people involved in a specific aspect of the 

process, there are Creo apps tailored to their precise requirements. It doesn’t matter what part you 

play in the product development process, Creo means you get to use the right tool for the job. 

#2 INTEROPERABILITY 

All of the Creo apps are able to communicate seamlessly with each other. This means your data can 

flow easily between the different apps that you are using. 

So, no need to recreate work as you move through the design process and no more siloes between 

different stages of product development. 

#3 COMBINED BENEFITS OF PARAMETRIC AND DIRECT MODELLING 

PTC Creo IntroductionUsing Creo means you can access both 3D CAD modelling approaches when 

you are doing your work, all in one tool. This means you have the control provided by parametric 

modelling, alongside the speed and flexibility of direct modelling. 
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#4 ABILITY TO WORK WITH MULTI-CAD DATA 

This benefit of Creo allows you to work with data from any CAD source. This means no recreating 

designs because of incompatible data, saving you time and money in the product development 

process. 

Creo is a solution, enabling companies to overcome the typical product design challenges of 

designing, analysing and sharing information between your teams, your partners and your 

customers. 

 

Getting Started with Creo 

 

Fig 2.1 – Creo upon starting up 

The main interface at Start Up looks as shown in Figure 2.1. The main areas and functions of this 

interface are as follows: 

The Folder Browser tab (Figure 2.1), located on the left of the screen next to the Model Tree tab, 

lists the folders on the computer or network. Browse the folders and view their contents in the 

Folder Browser. The Favourites tab is a multi-functional Web browser embedded in Creo. It displays 

models and tutorials from PTC.com and other websites. A preview window appears in the centre of 

the screen after the launch. 
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The Graphics area is a large grey area where the 3D model geometry is visible when a model is 

opened (Figure 2.2). This is the main area where the model geometry is developed and displayed. 

The user can rotate, move and zoom the model. 

 

Fig 2.2: Creo Part Modeling Interface 

Select working directory 

The Working Directory is a directory or a folder in the PC disc memory (hard drive, solid state disc 

memory, USB memory stick, network, etc.) where all models (objects) belonging to a project are 

stored. The user can set any existing folder with Read/Write permissions as a Working Directory. It 

is very important to do this immediately after starting Creo or switching to a new project. If a 

Working Directory is not selected, the software will save or open an object from the default 

directory (usually in C: drive). For example, an assembly model containing several parts will not 

open those models that are located outside the Working Directory. The missing part name will 

appear in red in the assembly Model Tree.  

 Rule number one is to set up a Working Directory immediately after starting the software! This 

ensures that all existing and new models (files) are opened or saved in one place.  

Click on Select Working Directory icon ( ) from the Home menu at Start Up (Figure 2.1) and set up a 

Working Directory. Alternatively, select File > Manage Session > Select Working Directory. 
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File menu options 

File menu options appear when selecting the File tab from the menu bar as shown in Figure 1.6. 

Some commands might be dimmed at Start Up. 

The main commands are: 

 New: Click on New (  ), (or File > New) to create a new model. 

 Open: Click on Open (  ), (or File > Open) to open a model. 

New and Open commands create a new model or open an existing model from the Working 

Directory. They can be activated directly from the Home menu after Start Up (Figure 2.1). 

 Save: Click on Save icon (  ), (or File > Save) to save the model in the current Working 

Directory, thus creating another version of the object. 

 Creo does not overwrite the existing file after Save. It creates a new file version containing the 

latest modifications.  

 

Fig 2.3: File Menu 

 Save As: Save As ( ) icon a sub-menu with three commands: 
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- Save a Copy: This command saves the current model with a new name. Also, it can 

save the model in a different file format that can be used to transfer a Creo model 

data to another CAD software. The most used file formats are: Stereolithography 

(*.STL) for 3D printing, STEP and IGES for transferring the 3D geometry into another 

CAD/CAM system. 

- Save a Backup: This command backs up an object to the current directory. 

- Mirror Part: This command creates a part as a mirrored copy of the current model. 

 Print: Print (  ) icon has a sub-menu with several commands to print the object from the 

active window to a printer as either a rendered image from the screen, a 2D drawing, a 

drawing in PDF format or a tessellated model in STL Stereolithography format. 

 Close: Click on Close icon ( ) to close the active window. Note that the object is still in 

the computer RAM, which is called Session. If the current model is closed accidentally, it can 

be opened back from the Session and then saved. 

Manage file 

Manage File (Figure 2.3) has a sub-menu with the following commands: 

 Rename (File > Manage File > Rename): This command renames the current object and its 

versions in the Session (computer RAM) and/or in the Working Directory. 

 Delete Old Versions (File > Manage File > Delete Old Versions): This command deletes all 

versions except the latest (with the highest variant number) of the current object from the 

Working Directory. 

 Delete All Versions (File > Manage File > Delete All Versions): THIS COMMAND DELETES ALL 

VERSIONS of the current object from the Working Directory (from the computer disc) and 

the Session. The software asks the user to confirm this action. One should be very careful 

when using this command!!! 

Manage session 

Session is the computer RAM allocated for all Creo-opened models (objects). Several objects (parts, 

assemblies, drawings, etc.) can be opened simultaneously and displayed in different windows 

within a single Session. Typically, the user works simultaneously on different models, belonging to a 

project, and switches from one window to another. 

Sometimes, a new Working Directory needs to be set up without stopping Creo. In this case, all 

opened objects in the Session need to be closed and removed from it to avoid memory conflicts. 

This is done with the following tools from the Manage Session menu (Figure 2.3): 

 Erase Current (File > Manage Session > Erase Current): 

This command removes an object (model) from the active window. 

 Erase Not Displayed(File > Manage Session > Erase Not Displayed): 
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It removes all objects from the current Session that are not displayed. 

 ·Select Working Directory: (the same command as in Figure 2.2). 

 ·Object List: Display the names of all objects in session.  

 

 The best way to start a different project located in another directory is to remove all 

models residing in the memory (In Session) and then to set up a new Working Directory as 

follows: 

Close all windows with objects. 

Click on Erase Not Displayed to remove them from the memory. 

A dialogue window asks for confirmation. Before clicking on Yes, make sure that all listed 

objects have been saved. 

Click on Select Working Directory to set up the new project directory. 

 

File names and conventions 

An object name can consist of letters and or numbers but cannot contain spaces or special symbols. 

The use of underscore symbol is permitted and it can also be used to separate some sections within 

the name. For example, MY_FIRST_MODEL is a correct name. Also, the software does not 

distinguish between upper and lower case letters. These rules apply to all Creo names, including the 

names of files, folders, features, parameters, etc. 

How to Open a Creo Object (file)? 

Always open a Creo object (file) from the software interface. NEVER double-click on a Creo file from 

the Windows File Explorer to open and launch the software. To avoid mistakes, follow this 

procedure: 

(1) Start Creo Parametric. 

(2) Click on File > Manage Session > Select Working Directory. 

This command sets up a directory to Save a new model(s) or Open existing model(s). 

(3) Click on File > Open ( ). 

This command opens a window with all Creo objects from the Working Directory. Select the model 

name and click on Open. 
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Functions of the Mouse Buttons 

The PC mouse is an essential input device in Creo 3D modelling. Every click of a mouse button 

generates an input for the software. It is important to understand and learn the functions of each 

mouse button when clicking on an icon (command) from the user interface or clicking on a model 

geometry item. In the beginning, it is difficult to remember all mouse button functions, but after 

some practice it will become second nature to use the correct button and key combinations. 

Usually, the software does not react if an incorrect button is clicked or if a wrong item selected. 

However, sometimes it may stop working or crash if the user repeatedly clicks a (wrong) button. 

Therefore, one should be careful and use the mouse buttons correctly. The main mouse button 

functions and combinations are explained in the following. 

 Left Mouse Button (LMB): 

The LMB is used to: click and initiate an action, such as click on interface icon, tab, tool, pull 

down menu, open a menu and other functions. For example to click on Open, Save, Extrude, 

Rotate and other icons (commands). 

In addition, the LMB is used to click and select (pick) a geometry item as input for a 

command sequence. For example to click on datum plane, axis, point, edge, feature, etc. 

Typically, the user performs a click and release action with the LMB to click and select (pick) 

an item.  

In order to make multiple selections and add (or remove) more than one geometrical 

item(s), the user must press and hold the CTRL key down (CTRL + Hold) and then continue 

selecting the items with the LMB. 

 Middle Mouse Button or the Wheel (MMB): 

This is used to accept the current selection or input. In 2D (Sketch) mode, the MMB is used 

to place dimensions and also to abort (stop) the current command. 

MMB is also used to rotate the model in the Graphics area and to view it at various angles. 

To rotate, place the cursor on a point inside the Graphics area, press and hold the MMB 

(MMB + Hold) and drag the mouse slowly to rotate the model. Some computer mice have a 

wheel instead of a middle button. The wheel rotation zooms-In or zooms Out the model. 

Rotating and zooming the model are constantly used during the modelling process. 

Another purpose of the MMB (or the wheel) is to translate the model on the screen. Press 

SHIFT and hold (SHIFT + Hold) with one finger, click the MMB, and then drag to translate the 

model. 

 Right Mouse Button (RMB): 

It is used to initiate shortcut and mini menus by clicking once or by pressing and holding for 

a few seconds (RMB + Hold). 
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Creo Modelling Interface 

The default, Part mode (part modelling) interface is shown in Figure 2.3. 

 

The main components of the interface are as follows: 

 

Main Menu — It is located on the top of the screen. Commands are grouped into tabs 

depending on their functions, such as File, Model, Analysis, Annotate, Tools, View, Flexible 

Modelling and Applications. Each of these tabs except File activates a specific ribbon 

interface. Each ribbon contains a number of icons, organized into groups, which activate 

commands or tools with specific actions. 

 The commands are context dependent, and some of them might be disabled (dimmed) if 

correct prerequisites are not available or if geometrical entities not selected. 

The ribbon interface is active when a new or an existing Creo object is opened in the 

Graphics area. Figure 2.3 shows Part mode ribbon interface with a part opened and shown 

in the Graphics area. Every Creo application, i.e. part, assembly, mould design, NC assembly, 

and others, has a specific interface and commands. 

 

Graphics Area — This is the screen area in which the model geometry is displayed. By using 

the mouse, the user interacts with the model, selecting geometrical entities such as plane, 

point, surface, edge, etc., in order to create a new model feature or modify existing model 

features. 

 

Ribbon — The Model ribbon (Figure 2.4) is a context-sensitive menu that contains the main 

commands (icons and drop-down menus). These are arranged in groups from left to right 

following the modelling workflow. 

 
Fig 2.4: Model Ribbon 

 

Message Area — A bar at the bottom of the screen under the Model Tree and Graphics area 

(Figure 2.3) providing prompts and help. 
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Graphics Toolbar (Figure 2.5) — It is a small bar under the ribbon used to control the view 

of the model or sketch. 

 
Fig 2.5: Graphics Toolbar 

 

 

Quick Access Toolbar — It is located on the top left of the screen. It contains the following 

commands: New, Open, Save, Undo, Redo, Regenerate and Windows (shown in Figure 2.6). 

 

 
Fig 2.6: Quick Access Toolbar 

 

The Regenerate command icon (  ) is frequently used in Part or Assembly mode to  

initiate the model recalculation after a change of a dimension or another parameter. 

 

Dashboard (Figure 2.7) — This is a submenu that will open after activation of a top-level 

command. For example, commands for creating Extrude, Rotate, Blend, Sweep, or other 

features have their dashboards. Each dashboard has command-specific tools and options for 

creating variations of the activated feature.  

For instance, the Extrude command) opens a dashboard that has options to create a 

protrusion (adding material) or cut (removing material). Also, the dashboard can switch to 

create a solid or surface feature. 

Click (LMB) on Extrude (i.e. Model > Shapes > Extrude) to activate the Extrude dashboard 

(Figure 2.7). If all necessary inputs are provided into the dashboard, for example, a 2D 

sketch (two concentric circles) and extrude depth (Figure 2.7), then a green tick (  ) is 

available to save the changes and close the Extrude command. 

 

Creo cannot continue if the command dashboard is still open. Click (LMB) on the OK green 

tick ( ) or Cancel (  ) icon on the right-hand side of the dashboard to close and 

continue. 
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Fig 2.7: Extrude command dashboard 

 

Model Tree (Figure 2.3) — It is a record of all features and parameters following the order 

of their creation. In fact, the model is a software programme containing commands and 

input values that Creo executes to create the model geometry. The Model Tree shows the 

model history. It updates every time new features are added or deleted. 

 

Creo Help — To access Creo Help Centre, click (LMB) on Help (  ) icon at the top right 

corner of the main screen (Figure 2.3). 

 

Use the Search tool (  ) and type into the search bar to quickly find anything related to 

Creo, e.g. ‘extrude’. The result activates the command or highlights it on the screen in real 

time. 

 

PTC Learning Connector (  ) — It is located next to Creo Help. It allows the user to log 

into the PTC University e-Learning database and access tutorials and videos. The user needs 

a Login name and Password. Most help however can be quickly sourced from the Creo Help 

Centre tab. 
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Changing Model Properties 

 

The model properties such as Material, Units, Accuracy, Tolerance etc. can be changed using 

Model Properties tab shown in Fig 2.8. 

File – Prepare – Model Properties 

 

 
Fig 2.8 Model Properties 
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ENGINE PARTS 

1) STUFFING BOX: 

 

 

 

Fig. Stuffing box 
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Parts list: 

Part No. Nam e Matl Qt y 

1 Body CI 1 

2 Gland Brass 1 

3 Bush Brass 1 
4 Stud MS 2 

5 Nu t, 
M1 

2 
MS 2 
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STEAM ENGINE CROSSHEAD: 

Crosshead is used in horizontal steam engines for connecting the piston rod and connecting rod. 

Figure 18.2 shows the part drawings of a steam engine crosshead. The crosshead, with the help of slide 

block 4, reciprocates between two guides provided in the engine frame. The gudgeon pin 3, connects 

the slide blocks with the crosshead block 1. This acts as a pin joint for the connecting rod (not shown in 

figure). The piston rod 2 is secured to the crosshead block by means of the cotter 5. The assembly 

ensures reciprocating motion along a straight line for the piston rod and reciprocating cum oscillatory 

motion for the connecting rod. 
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CROSSHEAD: 

Figure shows the details of another type of steam engine crosshead. It consists of a body or slide block 

1, which slides in-between parallel guides in the frame of the engine. The piston rod end 2 is fitted to 

the crosshead with the help of bolts 5 and nuts 6 and 7 after placing the brasses 4, and cover plate 3 

in position. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.Crosshead 

 

 

 

 

 

 

S.NO 

No. 

     Name Matl Qt 

y 
 

1 
 
Body 

 
Cl 

 
1 

2 Rod end MS 1 
3 Cover plate MS 1 
4 Brasses Bras 

s 1 

5 Bolt — 2 
6 Nut — 2 
7 Lock nut — 2 
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ECCENTRIC: 

It is used to provide a short reciprocating motion, actuated by the rotation of a shaft. Eccentrics are 

used for operating steam valves, small pump plungers, shaking screens, etc. The components of an 

eccentric are shown in isometric views Fig. for easy understanding of their shapes. Rotary motion can 

be converted into a reciprocating motion with an eccentric, but the reverse conversion is not possible 

due to excessive friction between the sheave and the strap. The crank arrangement, in a slider crank 

mechanism however, allows conversion in either direction. 

 

 Details of an Eccentric 

CONNECTING ROD 

PETROL ENGINE CONNECTING ROD 
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Assembly of connecting rod: 

 

                                                    Fig. Petrol engine connecting rod 
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OTHER MACHINE PARTS: 

SCREW JACK: Screw jacks are used for raising heavy loads through very small heights. Figure shows 

the details of one type of screw jack. In this, the screw 3 works in the nut 2 which is press fitted into 

the main body 1. The Tommy bar 7 is inserted into a hole through the enlarged head of the screw and 

when this is turned, the screw will move up or down, thereby raising or lowering the load 
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MACHINE VICE:  

The details of a plain machine vice are shown in Fig. It consists of the base 1 which is clamped to the 
machine table using two T-bolts. The sliding block 3 is fixed in the centre slot of the base by means of 
the guide screw 4. The movable jaw 2 is fixed to the sliding block with four screws 8 and 7. One of the 
serrated plates 5 is fixed to the jaw of the base by means of screws 6 and the other to the movable jaw 
by the screws 7. One end of the guide screw is fixed to the base by means of the washer 9 and nut 10 
(not shown in figure). The movable jaw is operated by means of a handle (not shown) which fits onto 
the square end of the guide screw 

 

 

 

Fig. Machine vice                                         
                        

PLUMMER BLOCK: 
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LATHE TAIL-STOCK: 
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VALVES: 

STEAM STOP VALVE: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Steam stop valve 
 

 

Sl. 

No. 

Name Matl. Qt 

y. 
1 Valve body CI 1 
2 Bonnet Brass 1 
3 Gland 

tightening nut MS 1 

4 Gland Brass 1 
5 Sleeve MS 1 
6 Coller MS 1 
7 Stuffing box 

packing 
Asbes

t 
os 

1 

8 Stem with 
screw MS 1 

9 Actuating 
screw end MS 1 

10 Screwed 
sleeve 

Brass 1 

11 Valve seat GM 1 
12 Screw MS 1 
13 Hand wheel CI 1 
14 Nut MS 1 
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SPRING LOADED SAFETY VALVE 
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Fig. spring loaded safety valve 

 

 

Part 
No. 

Na
m 
e 

Ma 
tl 

Qt 
y 

Part 
No. 

Na
m 
e 

Mat 
l 

Qt 
y 

1 Body Cl 1 8 Toggle-pin M
S 

1 

2 Valve seat GM 1 9 Lever guide M
S 

1 

3 Valve GM 1 10 Lever FS 1 
4 Cover Cl 1 11 Fulcrum pin M

S 
1 

5 Cover bush Bra
s 
s 

1 12 Weight Cl 1 

6 Spindle MS 1 13 Lever pin M
S 

1 

7 Toggle MS 1 14 Stud with 
nut 
M20 

— 6 

 

 

Fig. spring loaded safety valve 
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FEED CHECK VALVE: 

 It is used in boilers to regulate the supply of feed water and to maintain the water level. It is fitted 

close to the boiler shell and in the feed pipe line. Figure shows the details of a feed check valve. The 

valve prevents water from being returned to the supply line, due to steam pressure in the boiler. 

Hence, it functions like a non-return valve. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
S
N 
o. 

 
Na 
me 

Mat 
l. 

Qt 
y 

1 Body Cl 1 

2 Cover Cl 1 

3 Spindle MS 1 

4 Valve GM 1 

5 Valve seat GM 1 

6 Gland GM 1 

7 Hand wheel Cl 1 

8 Stud MS 6 

9 Stud MS 2 

10 Nut MS 6 
11 Nut MS 3 
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AIR COCK:  

This valve is used to control air or gas supply. The details of an air cock are shown in Fig. It consists of a 

plug 2 which is inserted into the body 1, from the bottom. The rectangular sectioned spring 4 is placed in 

position at the bottom of the plug and seated over the screw cap 

3. The screw cap is operated to adjust the spring tension. Lever 5 with square hole is used to operate 

the cock. By a mere 90° turn, the cock is either opened or closed fully. 
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INDUSTRIAL APPLICATIONS: 

1 Marine Gas-Tight Bulkhead Stuffing Box between Pump and Engine Room. 
 

 

2. Steam Engine Cross Head used in Marine/Locomotive engines. 

 

 

 

Eccentric 

 

https://hgmachinery.en.made-in-china.com/product/jbQJghRCgOTA/China-Marine-Gas-Tight-Bulkhead-Stuffing-Box-Between-Pump-and-Engine-Room.html
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Pistons used in Automobile 

 

 

SCREW JACK is used for lifting the load. 

 

Machine Vice: 
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Plumber block 

 

 

Lathe tail stock used in industries for different operations 

 

Feed Check valve 
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Steam stop valve 
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Code No: R15A0310 

MALLA REDDY COLLEGE OF ENGINEERING & TECHNOLOGY 
(Autonomous Institution – UGC, Govt. of India)  

II B.Tech II Semester supplementary Examinations, April/May 2019 
Machine Drawing 

 (ME)  

Roll No           

 

Time: 3 hours        Max. Marks: 75 

Note: This question paper contains two parts A and B 

 Part A consists of three Questions, answer any two questions. Each question carries     

            15 marks. 

Part B consists of one question which is compulsory. Which carriers 45 marks.  

****  

Part-A (30Marks) 

Answer any two of the following (2x15=30M) 

 
3. Draw the conventional representation of  following materials 

(a) Porcelain     (b) Fiber    (c) Lead    (d) Petrol     (e) Copper 

4. Draw the single riveted single strap Butt joint of plate thickness as 12 mm . 

5. Draw the half-sectional front view and side view of journal bearing which can accommodate 40 mm 

diameter shaft.  

 

 Part-B (45Marks) (1x45=45M) 

6. Assemble the parts of spring loaded safety valve as shown in the figure and draw 

a) Sectional front view 

b) Top view  
 

 

 

 

 
   

 

 

 
 

 

 
 

 

 

 
P.T.O 

R15 
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Fig. Spring loaded safety valve 
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Code No: R17A0310 

MALLA REDDY COLLEGE OF ENGINEERING & TECHNOLOGY 
(Autonomous Institution – UGC, Govt. of India)  

II B.Tech I Semester Supplementary Examinations, May 2019 
Machine Drawing 

 (ME)  

Roll No           

 

Time: 3 hours        Max. Marks: 70 

Note: This question paper consists of 2 parts. Answer any TWO Questions from part-A, Which 

carries of 28 marks and Part-B consist of one question which is compulsory which carries 42 marks. 

****** 

Part- A (28 Marks) 

Answer any two of the following (14*2=28) 

 

1. Draw the sectional front view of a universal coupling joining two shafts of diameter 50 mm. Show the 

dimensions. 

2. Draw the sectional view from the front and top view of a single riveted single strap butt joint with plates 

of thickness 15 mm. 

3. Sketch the sectional front view of rag foundation bolt of diameter 25 mm. Show the proportionate 

dimensions in the drawing. 

Part-B (42 Marks)  (1*42=42M) 
4. Develop the assembly drawing views as mentioned below of Screw Jack using the part drawings shown 

in Figure.1. 

(i) Half-Sectional Front View 

(ii) Top View  
 

Figure 1. Details of Screw Jack 

********* 
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Code No: R17A0310 

MALLA REDDY COLLEGE OF ENGINEERING & TECHNOLOGY 
(Autonomous Institution – UGC, Govt. of India)  

II B. Tech I Semester Regular Examinations, November 2018 
Machine Drawing  

 (ME)  

Roll No           

Time: 3 hours        Max. Marks: 70 

Note: This question paper Consists of 2 parts. Answer any two questions from Part-A, which 

carries of 28 Marks and Part-B consists of one question which is compulsory  which carries 42 

marks. 

****** 

Part- A (28 Marks) 

Answer any two of the following (14*2=28) 

 

5. Draw the three views of a hexagonal headed bold of nominal diameter 20 mm and length 80 mm with a 

hexagonal nut and washer. 

6. Draw the conventional representation of the following materials. 

(b) Cast iron (b) Lead (c) marble (d) glass (e) water (f) concrete (g) wood 

7. Draw the sectional front view and top view of a double riveted double strap chain Butt Joint to joint two 

plates of thickness 10 mm.  

Part-B (42 Marks) 
 (1*42=42M) 

 

8. Develop the assembly drawing views as mentioned below of an Eccentric using the part drawings shown 
in Figure.1. 

(iii) Half-Sectional Front View with top half in section 
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(iv) Side view from right 
 

Figure.1 Details of Eccentric 

*** 
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Time: 3 hours        Max. Marks: 75 

Note: This question paper contains two parts A and B 

 Part A is consists of Three questions among them Two questions should be answered           

            Which carriers 30 marks. 

Part B Consists of one question, which is compulsory, which carries 45 Marks.  

******** 

Part-A (30Marks) 

Answer any two of the following (2x15=30M) 

7. Draw the following material conventions 

(i)  CI   (ii) Water   (iii) Wood   (iv) concrete   (v) Leather   

8. Draw front view and top view of double riveted zig-zag lap joint of 10mm plate thickness. 

9. Draw the sectional front, top and side view of a knuckle joint to join two rods of diameter 30 mm each.   

                                                 

Part-B(45Marks) (1X45=45M) 

10. Assemble all the parts of the stuffing box for a vertical steam engine, show the fallowing figure 

and draw 

a) Half sectional view from the front, with left half in section 

b) View from above. All dimensions are in mm 
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